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Overview 

 

Figure 1: OECD eXplorerôs getting-started layout is based on three dynamic multiple-linked and 

coordinated views (Choropleth Map Layer, Scatter Plot and optional Parallel Axes Chart (PAC)). This analysis 

called ñageing population in OECD countriesò shows the indicator ñElderly Population Rateò for all OECD 

TL2 regions and represents the colour scale. The Scatter Plot shows the relation between ñPopulation 65+ò vs. 

ñPopulation 15-44 yearsò (horizontal axis). OECD eXplorer opens with a preloaded Story with selected 

indicators and displaying all four OECD continents in the Choropleth Map. The Storyôs metatext is shown in the 

Story Panel (right). A continent is selected by a click on the cross icon in each map view. Splitters can adjust the 

size of any of the views. Indicators to be analysed are selected in the combo boxes attached to the Colour Legend 

and Scatter Plot axes. The optional view PAC is open in the View Menu or use the lower splitter. 

OECD eXplorer (eXplorer) is a web compliant application that enables the visualization of socio-
economic information at detailed territorial level providing clear insight on regional differences and 
performance within a country and comparison of different areas across countries. eXplorer enables 
users to explore simultaneously spatial, temporal and multivariate data from multiple perspectives, 
to discover interesting relationships, to share their incremental discoveries with colleagues and 
finally to communicate selected relevant knowledge to other users.  

eXplorer is composed of GeoAnalytics Visualization (GAV) components facilitating a broad 
collection of dynamic visualization methods integrated with the Adobe© Flash© and Flex© 
development platform. In this respect, eXplorer represents a leading edge tool having being adapted 
to the Internet and used as a web-enabled toolkit. 

 The statistical dataset contained in eXplorer is the OECD Regional database which contains yearly 
time-series for around 50 indicators on demography, economy and labour market opportunities, 
environment, social issues and innovation related activities for more than 1,700 regions of the OECD 
countries. Regions within each OECD country are classified on the basis of two territorial levels: the 
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higher level (TL2) consists of 337 large regions (figure 1) while the lower level (TL3) is composed of 
1,708 small regions.  

In order to detect trends and gain understanding and knowledge within the data, it is convenient 
to view it through a number of different visual representation methods, each of which is best suited 
to highlight different patterns and features. eXplorerΩǎ ǳǎŜǊ interface is divided into three dynamic 
linked views (figures 1 and 2): Choropleth Map, Scatter Plot and Parallel Axes Chart (PAC). These 
views are separated by interactive splitters (figure 1), allowing the user to scale the sizes of individual 
views. The Scatter Plot share views with the Data Grid, while the PAC shares with a Time Graph (only 
for time animation).  

Coordination between views uses a novel data linking method where the visualization 
components use the same data model and colouring scheme. A selection made in one of the 
visualization components propagates to all the others. An example, exploring only Italian regional 
data, is shown in figure 2, facilitating a linked coordination between the three main eXplorer views: 
choropleth map, scatter plot and parallel axes. The same colour map ǊŜǇǊŜǎŜƴǘƛƴƎ ƛƴŘƛŎŀǘƻǊ άelderly 
dependency rateέ is applied to all views and the regions Napoli and Trieste (Italy) are highlighted in 
all views. 

 

Figure 2: Example of an eXplorer linked view scenario (choropleth map layers, scatter plot and parallel 

coordinates) for the Italian TL3 regions facilitating for the analyst to discover patterns of events and 

relationships within a geospatial context. This layout uses points (Scatter Plot), lines (PAC), and polygons (map) 

to explore regional data. A Google map ñterrainò layer is integrated as a separate map layer together with GAV 

coloured shapes layer. The chosen colour map indicator is ñelderly dependency rateò. Two regions Trieste and 

Napoli are highlighted in all three views for comparison. The profiles for the two regions can be compared 

together with the OECD mean value. Each of the five vertical axes represents an indicator.   
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 eXplorer map layers  

 OECD eXplorer optional supports a Google Map layer that integrates various types of Google 
Maps (Street, Satellite, Hybrid, Terrain) with the eXplorer shaded regional map and country border 
layer (figure 3a). The Google Map layer with, for example, city names for Turkey (figure 2) can make 
the identification of a geographic location easier. However, Google Map requires more memory 
(RAM) and can also reduce interactivity and slow down time animation. We recommend therefore 
that you avoid this version if you have a computer with little or modest memory and performance. 
However, a powerful computer could have much benefits from the integrated map layers. 

 

Figure 3a: eXplorer Map layer. eXplorer facilitates a novel map layer architecture that allows the user to 

combine maps from various GIS sources.  A standard use is shown here where 4 layers are integrated in the 

Choropleth Map view pie chart, colour shape layer, country border layer and the external Google Map layer. 

All layers are under control by the user and can be turned off/on.  

 

Figure 3b: eXplorer Map layer control panel. Data Map (Heat Map) layer 60% opacity; Google Map layer 
turned On;  Google Map layers:  Street, Satellite, Hybrid, Terrain; Border layer turned Off;  
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Figure 3c: eXplorer Map layer control panel. Google Map layer turned off; Data Map (Heat Map) layer 

100% opacity; Border layer turned on; 

 

 

Figure 3d: eXplorer for EU with and without Google Map street layer 
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Load data in eXplorer  

 

 

Use the menu Indicator to Load Data. 
First select territorial level of regions 
(small or large) in the right menu then 
select data for a άsingleέ year, άlatestέ 
available year or άtime spanέ. Data are 
organised into categories 
(Demographics, Economic, Social and 
Innovation). Select indicators by clicking 
in a box. 

 

 

 

 

For a single yearé  

All indicators of the OECD regional database and their associate data are preloaded in eXplorer and 
can therefore be accessed immediately. To access all the data, use the top menu Indicators>Load 
Data window. CƛǊǎǘ ǎŜƭŜŎǘ άterritorial levelέ mode (TL2, TL3 or TL3+NOGύΣ ǘƘŜƴ ǎŜƭŜŎǘ άlatest dataέΣ 
άǎƛƴƎƭŜ ȅŜŀǊέ ƻǊ ŀ άǘƛƳŜ ǎǇŀƴέ ŦƻǊ ŀƴƛƳŀǘƛƻƴ ƳƻŘŜΦ 5ŀǘŀ ǘƘŀǘ ƛǎ ŀǾŀƛƭŀōƭŜ ŘŜǇŜƴŘǎ ƻƴ ȅƻǳǊ ŎƘƻƛŎŜ ŀƴŘ 
will be listed in the left column organized according to topics Demographics, Economic, etc. Load as 
many indicators as you want (previous choices are saved). If you switch from one territorial level to 
another previous choices are lost and you must select data from start again. 

éOr a time span of years 

In time span (animation) mode, ȅƻǳ Ŏŀƴ ǎŜƭŜŎǘ άƳƛƴƛƳƛȊŜ ǘƛƳŜ ǎǇŀƴέ ǿƘŜǊŜ ǎŜƭŜŎǘŜŘ ƛƴŘƛŎŀǘƻǊǎ 
must have data for all years or alternative άƳŀȄƛƳƛȊŜ ǘƛƳŜ ǎǇŀƴέ ǿƘŜǊŜ ǎŜƭŜŎǘŜŘ ƛƴŘƛŎŀǘƻǊǎ Ŏŀƴ ƘŀǾŜ 
άƴƻ Řŀǘŀέ ŦƻǊ ŎŜǊǘŀƛƴ ȅŜŀǊǎΦ ¢ƘŜ ƛŎƻƴ ƴŜȄǘ ǘƻ ǘƘŜ ƛƴŘƛŎŀǘƻǊΩǎ ƴŀƳe shows the available years. 

 1) Indicator data are preloaded; 
 2) Data can be input from a client local data file (the format is 
described in the Help ƳŜƴǳ άIƻǿ ǘƻ ƭƻŀŘ ȅƻǳǊ ƻǿƴ Řŀǘŀέ; 
3) A Story can include external data (not available in the 
preloaded data source). Stories built from temporal data are 
ƳŀǊƪŜŘ ǿƛǘƘ ŀ άƳƻǾƛŜέ ƛŎƻƴΤ 
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éAnd add your own external data 

eXplorer also supports to import your own data using an Excel-like format: Unicode. Additional 
data can be loaded using the top menu Indicators> load your own data window. The additional data 
must, of course, be related to the OECD regions and maps. A detailed description of the data format 
can be downloaded from the Help menu. Note: If you want to combine OECD regional data with your 
own data then you must FIRST load the OECD regional data and THEN read your own related data. 
 

 

Example data set, for the Italian  NUTS 2 (TL2) regions, 5  indicators, all Meta information filled in.  
eXplorer will use this to display the data in a more comple te way. 

 

Example data set for time data. See more information in separate documentation that can be accessed in Help  
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How does your region stack up?  

Choropleth Map View 

 

Figure 4: The standard eXplorer layout with a Choropleth Map View (including the colour legend) and 

associate Scatter Plot. The mouse is placed over Cataluña and a tooltips is displayed. 

The Choropleth Map view is based on our layered map architecture. The Choropleth Map view 
(figure 1) shows the geographical areas of all OECD regions. Each region is coloured according to the 
current assigned colour map indicator. To focus on one of the four continents, click the small button 
in the bottom right corner of one of the views. This will switch to a single map view for selected 
continent. By selecting, for example, Europe, all regions and their associate data from the rest of the 
world will be hidden in all views. The other views will thus only show data for, in this case, Europe. 
The toggle button in the top map view is used to turn on/off the Google Map layer (only available in 
the continental version). You find more controls in the Option Menu. 

Basic pan and zoom functions are available through mouse left-click and drag (pan) and mouse wheel 
scroll (zoom) respectively. Alternative you can use the pan-zoom GUI panel in the upper left corner. 

 The actual value for a region is displayed by moving (hovering) the mouse above it (tooltips). By 
clicking with left mouse button on a region, it becomes selected (highlighted) in the map but also in 
all other views (see figure 4 where Cataluña is emphasized in the Map and Scatter Plot views) You 
can select (highlight) several regions by clicking with the mouse on the region and pressing the CTR 
button on the key board at the same time. 
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Select countries to be explored  

 

Figure 5: Selected countries Germany, Czech Republic, Austria and Switzerland are explored for TL3 regions 

in a map and table lens.  

Select individual countries to explore. Menu Options >Choose Regions Group. Mark countries to 
be explored:  Austria, Germany, Czech Republic etc. Only the selected countries will be coloured in 
the map and displayed in the Scatter Plot and PAC. 

 

Colour Legend and Colour Scale 

 

Figure 6: The Colour Scale Legend plays an important role and provides many features and options that are 

important and can well influence the visual result. A divergent colour scale is applied as default together with 

a statistical method based on percentiles to calculate five suitable class values based on the selected data 

(figure 6B). 50% of the regions with lower values are coloured in blue and regions with higher values in 

yellow-red. Alternative linear calculation based on Min and Max values are applied (figure 6C). The class 

value sliders can be moved dynamically or by clicking on a class value box (figure 6D), the user can assign 

preferred exact values.  
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Colour coding is a fundamental technique for mapping data to visual representations with three 

fundamental goals: 
1) To serve the purpose of the map based on its intended audience, use and data; 
2) ¢ƻ ŎƻƳƳǳƴƛŎŀǘŜ ǘƘŜ ƳŀǇΩǎ ƛƴŦƻǊƳŀǘƛƻƴ ƛƴ ǘƘŜ Ƴƻǎǘ ŜŦŦƛŎƛŜƴǘ ƳŀƴƴŜǊΣ ǿƛǘƘ ǎƛƳǇƭƛŎƛǘȅ ŀƴŘ 

clarity; 
3) Intuitive interactive tools to enable users to adapt colour scales according to their needs; 
 Colour coding is often provided in a limited way only or it is not used effectively. Furthermore, 

adapting colour scales automatically by applying a simple minimum-maximum-scaling often results in 
visual representations of different views on the data which cannot be compared with each other. 
This chapter describes how appropriate automatic or user defined colour coding schemes can 
enhance the visual exploration of spatial or spatial-temporal data. From a collection of schemes (see 
figure) the user chooses the most appropriate one (sequential or diverging) wƛǘƘ ǊŜǎǇŜŎǘ ǘƻ ǘƘŜ ǳǎŜǊǎΩ 
visualization goal. The default scheme is a scientific proven diverging blue-to-red colour scale. 

 

The eXplorer scalar colour mapping area (colour legend) is 
used to assign colour to each scalar value in the dataset. This 
will allow you to, for example, assign a blue colour to regions 
ǿƛǘƘ ŀ ƭƻǿ άǇƻǇǳƭŀǘƛƻƴ ƎǊƻǿǘƘ ǊŀǘŜέ ǿƘƛƭŜ ŀǎǎƛƎƴƛƴƎ ǊŜŘ ǘƻ 
regions with higher growth rate. An example of this interface is 
shown in figure 1 and 5.  

The selection of the indicator that controls the colour map 
can be done in three ways: 1) through the combo box next to 
the colour legend (ŦƛƎǳǊŜ с! ά{ŜƭŜŎǘ LƴŘƛŎŀǘƻǊέύ; 2) the top icon 
to the left of the colour legend (ά/ƻƭƻǳǊ {ŎŀƭŜ {ŜƭŜŎǘƛƻƴέύΤ        
3) clicking on the indicator name in the headers of Parallel 
Coordinates axis (see more below). 

By assigning an indicator for the colour scale associated with 
the colour legend, all views will be coloured accordingly. The 
region with the highest data value will get the colour specified 
at the top of the colour range, and the lowest will get the 

bottom colour. All regions in between receive a scaled colour based on their respective values. 
eXplorerΩǎ standard approach of the visualization scales the colour map according to value density 
based on percentile calculations (figure 6B), which means that value ranges with a high amount of 
regions receive a larger range of colours to help distinguish them.  

The default colour scale representing the values associated with an indicator is considered within 
the regional data set. Perceptual distances within a colour scales reflect distances in the data. 
Moreover, a colour scale could reveal whether a selected indicator contains zero values by creating 
intervals. The first (top) icon (6A) ƛƴƛǘƛŀǘŜǎ ǘƘŜ ά/ƻƭƻǳǊ LƴŘƛŎŀǘƻǊ ŀƴŘ {ŎŀƭŜέ (6D), where the user can 
choose a diverging colour scale (blue-to-red or red-to-blue etc) or sequential. 

The third icon (6A) from the top (percentile distribution) splits the data into six intervals or bins 
based the 5th, 25th, 50th, 75th and the 95th percentiles (figure 6B and result in 7A). This provides a 
better automatic distribution of colours related to the data based on an accurate statistical method 
and the visualization is improved in a way that differences between values can be more easily 
detected. Colour scale values can also be adjusted dynamically by moving the handlers. The 
percentile and corresponding data values are shown to guide the user when moving any of the 
handlers attached to the colour scale legend (figure 8B).  
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The user can also switch to 25th, 50th and 75th or 10th, 50th and 90th percentiles by moving the 
mouse over the percentile icon to the right and an arrow will appear giving the user a choice. Note, 
the percentile calculation cannot be used in time animation when the linear scale is better.  

The second icon (6B) uses a linear interpolation based on the minimum and maximum values and 
divided into six classes with equal distance, this is effective if the structure of the data is accurately 
represented and for time animation. However, linear interpolation leads to problems if the values of 
an indicator are not uniformly distributed (e.g. if outliers are present). In this case a wide range of the 
colour scale represents a small number of values and the majority of values are placed in a narrow 
range of the colour scale. See result in 7B. 

The scale value boxes are sliders and can be moved dynamically. The user can also click on the 
scale value (6D) to assign a user preferred value - a box is shown for editing the value. This method is 
appropriate to assign, for example, a "zero value" in a diverging colour scale (blue-to-red etc).  

The last icon άǳǎŜǊ ǎŎŀƭŜέ gives the user the possibility to assign own discrete user scale values 
that don't reflect distances in the colour scale, i.e. the user has control of both the colour distribution 
and scale values for maximum customization. The user clicks (6D) on each scale number and assign a 
new value.  This is especially useful for Time Animation when linear interpolation is used to calculate 
the class values. 

 

Figure 7: A: percentile 5
th
, 25

th
, 50

th
, 75

th
 and 95

th
; B: linear colour scale; 

The dynamic handlers (sliders) in the colour legend can be moved to assign preferred class values.     
Figure 8 ǎƘƻǿǎ ǘƘŜ ǊŜǎǳƭǘƛƴƎ ƳŀǇ ǿƛǘƘ ƛƴŘƛŎŀǘƻǊ άǇƻǇǳƭŀǘƛƻƴ ƎǊƻǿǘƘ ǊŀǘŜέ. The user has first assigned 
0.0 to the centre point (where blue change to yellow/red) in the diverging colour scale. Double click 
on the class value to be edited and a box pops up, assign a new value then OK. Next, the dynamic 
handlers are moved to new suitable class values -1, -0.5, +1 and +2. Regions with high and low 
άǇƻǇǳƭŀǘƛƻƴ ƎǊƻǿǘƘ ǊŀǘŜέ can more easily be distinguished.  
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Figure 8a: Population Growth Rate vs. GDP Growth Rate for 1995-2005.  A diverging (blue-to-red) colour 

scale based where the user has assigned the class value 0.0 to the break point between blue and red. This means 

that regions with negative growth value will be blue and positive yellow-to-red. In the right scatter plot view, we 

see the correlation between GDP Growth rate and Growth Difference Population. 

 

Figure 8b:The fourth icon from the top assign a discrete colour scale (instead of a linear). 

Click here to apply a 
legend with discrete 
values at equal distances 


